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Introduction 

Why epublishing?  

I wrote a book called Writing Realistic Dialogue & Flash Fiction. I published it through Central 

Ave Press for a then whopping 10% royalty. The price is $14.95. To this day, each time one copy 

of that book sells, I earned $1.49. When 100 copies sell, I pocket $149.50. Of course, from that I 

have to deduct time spent on the road, in hotel rooms, at book signings, etc. 

Years later, I convinced the publisher to revert electronic rights to me. I published it again as an 

ebook. I get a 78% royalty. The price is $5.99. Each time a copy of that book sells, I earn $4.67. 

When 100 copies sell, I pocket $467. From that I have to deduct... well, nothing really. 

That’s what we in the business call Very Good Math. It’s why I encourage everyone I like to 1) 

polish your work until it can’t be polished anymore and 2) publish it digitally. 

Famed science fiction (and other genres) author Dean Wesley Smith strongly advocates 

electronic digital publishing, as do I. After all, why shut out the most rapidly growing portion of 

the publishing market? Dean provides a great deal of factual, practical information in his Think 

Like a Publisher series (see http://www.deanwesleysmith.com/?page_id=3736). I strongly urge 

you to read what he has to say.  

Perhaps the most important point he makes is that many first-time epublishers believe they can 

publish to one venue (for example, Amazon Kindle) and then sit back and watch the money roll 

in. That isn't how it works. Rather, Dean says (and I concur) you should get your work into as 

many venues as possible. Instead of trying to sell 1000 books on Amazon.com every month, try 

to sell 10 books in 100 different venues every month.  

There are three major keys to becoming a successful digital publisher: 

1. Format (lay out) your Word document correctly. Remember that old saying about an ounce of 

prevention being worth a pound of cure? Same thing here. Putting in the effort on the front end 

will save you massive headaches later.  

2. Use a distributor to get your books into as many different sales venues as possible. This is a 

direct result of having followed the first key. 

3. Market, market, market. 

I use Smashwords to convert my Word documents to the various eformats (most notably .epub 

for Apple, the Barnes & Noble Nook, and most smart phones; .mobi for Amazon Kindle; and 

http://www.deanwesleysmith.com/?page_id=3736


.PDF for use on the reader’s computer with free Adobe Reader software). Because I’m very 

careful to format those Word documents correctly, they move smoothly through the conversion 

and vetting process and are almost routinely accepted into the Smashwords Premium Catalogue. 

Once they’re accepted in the premium catalogue, Smashwords distributes them, per my 

instructions, to Apple, Baker & Taylor, Barnes & Noble, Diesel, Kobo, Sony and others. (I 

distribute my works to Amazon myself.) Smashwords even provides a free ISBN for those 

venues that require it (primarily Apple and Diesel). 

Remember I mentioned getting your work into as many different sales venues as possible? 

Barnes & Noble is now in the US and the UK. Diesel, Kobo, and Sony are worldwide sales 

venues. And Apple and Amazon, combined, sell in eighty nations at last count. That’s easily 100 

venues or more, and you can also look into venues like Scribd and XinXii. 

Most of this book is devoted to addressing the first major key to being a successful epublisher: 

formatting your Word document so it will move smoothly through the conversion process. 

There’s also a segment on how to successfully submit your correctly formatted Word document 

to Smashwords, Amazon and even Barnes & Noble. Because the requirements for ebook covers 

are much more stringent now, I’ve removed the ebook cover creation segment from this update. 

Instead, I offer only a few recommendations in that regard. I’ll also touch on marketing. 
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Formatting Your Word Document 

Important: Microsoft Word adds a lot of behind-the-scenes code and formatting that you 

won’t necessarily see on the screen. To avoid issues,  

1. Before you begin formatting, select the entire document (press Ctrl/A on your PC  or 

Command/A on your Mac) and select Normal Style. (If you aren’t sure how to use styles, check 

your Help menu.) All of your text should change to Normal Style. There should be no bold, for 

example, and all the text should be the same size, aligned the same, with the same line spacing 

and so on. Then go back and alter what you need to alter (centering some text, making some 

bold, and so on). 

2. Do not use the Tab key anywhere for any reason, period. Forget the Tab key exists.  

3. Do not insert a text box anywhere for any reason, period.  

4. Do not use headers or footers. Smashwords sees those as text boxes. 

http://www.scribd.com/
http://www.xinxii.com/


5. Do not use the spacebar to add more than one space even after a sentence. Modern word 

processors adjust that space.  

5. Do not use Word’s automatic features, especially the Table of Contents macro or any sort of 

Indexing function. You should also turn off Word’s AutoFormat and AutoCorrect features. To 

do this, find your AutoFormat and AutoCorrect dialogue boxes and uncheck everything. When 

you use Microsoft Word’s automatic features and macros, it adds a lot of code behind the scenes, 

and that code will cause odd text variations in the finished ebook file. Even if you wouldn’t mind 

publishing a soup sandwich, the Smashwords conversion engine usually will spit those out and 

make you do the over.   

To publish with Smashwords, and to ensure your book is accepted into their premium catalogue 

so they can distribute it as I described above, you must present your Word document (.doc) per 

certain strict guidelines. Note: Smashwords will not accept Word 2010 documents (.docx). Be 

sure it's saved as .doc (Word 97 to 2003) before you send it.  

By the way, Smashwords puts out a pretty good (and free) Style Guide, but it's filled with 

information on what not to do and is unnecessarily convoluted and repetitive. That’s why I wrote 

this book.  

For a Nonfiction Book 

First, for a nonfiction book, I recommend using 1.5 line spacing with no indent of the first line of 

the paragraph (as in this book). To easily achieve this press Ctrl/A on your PC (Command/A on 

Mac) to select the entire document. Next, in the menu at the top of the page, select Home (or 

Format) > Paragraph. You should get a dialogue box similar to the one below. For a nonfiction 

document, I recommend you follow the settings shown below exactly.  

This is a screenshot of the Indents and Spacing tab of the Paragraph Format dialogue box for a 

nonfiction book. It shows the correct formatting for the body of a nonfiction book: 

http://www.smashwords.com/books/view/52


 

This book is an example of a nonfiction publication. The title of the overall text is 14 point 

Times New Roman. All subtitles and the body text itself is 12 point Times New Roman. You can 

see all the paragraph settings. Note that the overall alignment is set to Left. More on alignment 

later. Line spacing is 1.5 and that the Indentations and Spacing Before are set to 0. The Spacing 

After is set to 6 pt. That adds space between paragraphs (like in this book) without using the 

Return key. (Instead, if you want, you may set Spacing After to 0 and hit your return key twice at 

the end of a paragraph.) If you set the Spacing After to either 6 pt or 12 pt, use your Return key 

only once after a paragraph. You can use it twice, if you want, after a major section ends. Also, 

you'll notice the At: block to the right of Line Spacing is blank. Be sure it's blank when you 

submit your nonfiction .doc to Smashwords. 

Another note on alignment—I recommend setting the entire document to Left alignment at first. 

Later, you can go back and Center the few text items that need to be centered at the beginning of 

the book. Also, it's important to note that any photos (in this case, screenshots) are centered. One 

more note on photos—before you submit your .doc to Smashwords, right click each photo. In the 

dropdown menu, click Format Picture. In the dialogue box that pops up, click the Layout tab and 

be sure each photos is set to In Line with Text.  

Note—if you want to indent any subsections or examples (this paragraph is an example of 

itself) highlight the whole subsection or example and use the paragraph formatting tool (or 

the bottom square slug on your ruler) to indent the whole thing by .25″. A half-inch is too 

far. Remember, some folks will see your work on an ereader or even on a smart phone. 



For a Fiction or Memoir Book 

As before, be sure to select your entire document before you begin. Press Ctrl/A on your PC 

(Command/A on Mac) to select the entire document. Next, in the menu at the top of the page, 

select Home (or Format) > Paragraph.  

If you compare the following screenshot with the nonfiction settings in the first one, you’ll find a 

few differences. Most notably, the first line of each paragraph is indented by .25″ or .30" 

(remember, a half-inch is too far) and there is no additional space between paragraphs. Again, for 

a fiction or memoir book, use these settings exactly, including the At: being left blank. 

This screenshot is the Paragraph Format dialogue box for a fiction book or story. 

 

For Both Fiction and Nonfiction Books 

Other than as noted above, the settings are identical for fiction and nonfiction. For example, in 

the Paragraph Format dialogue box, to the right of the Indents and Spacing tab you'll see the Line 

and Page Breaks tab. With your entire document selected (Ctrl/A on your PC or Command/A on 

Mac), in the menu at the top of the page select Home (or Format) > Paragraph. Click the Line 

and Page Breaks tab and make sure all the boxes are unchecked. (You might have to click each 

box twice, to put a check mark in it and then clear it.) Click OK.  

Now with the entire document still selected (Ctrl/A on your PC or Command/A on Mac), open 

the Paragraph Format dialogue box one more time, click Tabs at the bottom, then click Clear All 

and click OK again. Now you're finished with this part of it. 



The third screenshot is the Global Search and Replace screen. This is for both fiction and 

nonfiction. 

 

In the Global Search (Find and Replace), click the Replace tab. (See it peeking from behind the 

left side of the pop-up menu?) You'll see a rectangular button on the left that says << Less and 

another that says More >>. (In this screenshot, More>> is behind the pop-up menu.) Click the 

More >> button, and the screen will expand downward. At the bottom of the page click Special. 

The pop-up list you see in the screenshot will appear. On that list, select Tab Character (it will 

appear in the Find What box) and make sure there’s nothing in the Replace With box, then click 

Replace All. (You can see Replace All to the right of the pop-up menu.) Do the same thing with 

Column Break, Field, Manual Line Break, Manual Page Break, and Section Break. 

After this, double click on the top and bottom of one of your manuscript pages and make sure 

there is no header or footer, even page numbers. (As an alternative, in the Word menu click 

Insert. Then click the little arrow at the bottom of Header and click Remove Header. Then I do 

the same with Footer. This ensures there is no header or footer.) 

Finally, in the Word menu, click Insert again, then Bookmark. When the dialogue box pops up, 

be sure the Hidden Bookmarks box is checked at the bottom of the little dialogue box. Delete any 

bookmarks that appear in the list unless you specifically put them there. In the next section you'll 

add bookmarks intentionally to create a linked, interactive table of contents just like the one in 

this book.  
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Preparing a Linked Table of Contents 

This is actually a three-step process, and it can be tedious. Be as attentive to detail as possible 

and hang in there. It will be well worth it. First you will add bookmarks (targets for your 

hyperlinks) to the headings or titles in your book; second, you’ll add hyperlinks to the TOC 

(Table of Contents) items so that when your reader clicks a TOC item, he will be transported to 

the same item in the body of the book; third, you’ll add a hyperlink near each bookmark (like 

Return To Top) that, when clicked, will transport the reader back to the TOC.  

Note: Smashwords will automatically generate an interactive TOC for any work that has 

headings marked "Chapter 1," "Chapter 2," etc. so you don't have to worry about those. These 

instructions are for nonfiction manuscripts, or for works that have multiple subtitles, such as 

poetry collections or short story collections. 

Important—Again, do not use Microsoft Word’s automatic table of contents feature to 

build your TOC. Doing so will prevent the Smashwords conversion engine from converting 

your manuscript properly. Use bookmarks and hyperlinks instead, as explained in this section.  

For a nonfiction manuscript of any length and for a poetry collection or short story collection, 

it’s a good idea to have a linked TOC. It isn’t difficult to create, but it can be a tedious process. 

Here's how to do it:  

Creating Bookmarks 

When you create a bookmark, you’re creating a target. Your reader will click on a link in the 

TOC, and the hyperlink there will direct him to the corresponding item in the body of your book.  

To create the bookmarks, move through your document. Stop and select (highlight) the heading 

or title of each poem or short story important nonfiction section that’s important enough to be a 

live link. For example, in this book, you’ll notice that some of the smaller headings (like 

Creating Bookmarks) are not bookmarked TOC items.  

From the Word menu at the top of the page, select Insert > Bookmark. Name your bookmark 

corresponding to the TOC item and then click Add. Note that there can be no spaces in the 

bookmark name. For example, if you highlight Part One, when you go to Insert > Bookmark, 

you have to name that bookmark PartOne. Use at least the first word of your heading or the 

chapter number you’re linking to, because later on, when you add the hyperlinks to the TOC to 

“aim at” these bookmark targets, Word will display the bookmark shortcuts in alphabetical order.  



After you've inserted all the bookmarks that you intend to insert, return to your table of contents 

at the top of your book and highlight the phrase Table of Contents. Click Insert > Bookmark one 

more time and label this last bookmark something like ATOC. (The A before the TOC will place 

it at or near the top of the bookmarks and make it easier to find.) This will enable you to link all 

of the section headings or subtitles in the body of your book back up to the top of the table of 

contents.  

Linking TOC Items to Your Bookmarks 

Next, add the hyperlinks to your chapter listings. Highlight a TOC item, then right click your 

mouse. A menu will pop up.  

On that menu, click Hyperlink. Word’s hyperlink dialogue box will open.  

On the left hand side, click Place in This Document. You will now see your bookmarks listed in 

the main window.  

Select the appropriate bookmark and then click OK.  

Repeat this process for every item in the table of contents that you want to make a clickable link. 

Linking the Body Parts Back Up to the Top 

As a final step you can link the section headings or subtitles in the body of your manuscript back 

up to the TOC. This makes it easy for the reader to jump back to the top of book.  

From your TOC, click on the link to jump to your section heading or subtitle.  

Then click Insert > Hyperlink, and then select Place in This Document.  

When the bookmarks are showing in the main window, select the bookmark labeled ATOC, 

assuming that’s what you named your table of contents bookmark in the step above.  

Repeat this process for every chapter and indexed item.  

Note: As an alternative, at the end of each section or chapter, you can insert a small phrase like 

Return to Top and link that phrase to the table of contents instead of linking the actual indexed 

item. I find this a cleaner way to do things. 

In this book, I’ve added a small Return to Top link just above each linked heading. For example, 

below you’ll see a small Return to Top link just above the next linked heading, My Personal 

Process. 

Note also that you can link any part of your book to any bookmark. This makes it possible to link 



between sections, or to manually create linked footnotes, endnotes or indexes. Try to link only to 

important headings. Too many links can create frustrating problems for the reader. Can you 

imagine reading along when all of a sudden your finger brushes over a link and the text jumps to 

a new location? 

Now all that remains is to add the necessary Front Matter and Back Matter to your manuscript. 
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My Personal Process 

I mentioned earlier in this book that I submit one file to Smashwords for distribution to several 

markets, but that I also distribute to Amazon and a few others myself. For that reason, I prepare 

two different versions of the document. 

To make everything more efficient, I create several files and keep them all in one file folder for 

each title. I strongly recommend you do the same. Below are a series of screenshots. Say I want 

to send my collection Stories from the Cantina to a friend. On my desktop is a file folder named 

Books. Inside that is my EPub folder. It contains folders for the books I’ve published digitally.   

In the first screenshot, I’ve already opened the Books folder and the EPub folder: 

 

 

In the next screenshot, I’ve opened the Cantina Stories folder. Here you can see the individual 

story folders (numbered to indicate their sequence in the collection). There are also two 

unnumbered stories that are not included in the current collection, as well as the folder for the 

overall collection itself: 



 

In the next screenshot, I’ve opened the Stories from the Cantina I folder. There you can see the 

files I typically keep in each folder for each story or book: 

 

As you can see, my Stories from the Cantina folder contains ten files. The Promo file contains 

the title, the cover teaser, a description of the story, my bio and the keywords search engines can 

use to find this book:  



 

The second file is the manuscript version of this collection for submission to agents and print 

publishers. Per standard manuscript format, it's in 12 point TNR, double spaced, etc.  

The third file is the Smashwords edition of this collection. Here's the front matter I use now for 

all files I submit to Smashwords (for myself or for my authors):  

 

The fourth file is the StoneThread edition of this collection. Here's the front matter I use now for 

all files I submit for myself or for my authors to Amazon or anywhere else except Smashwords. 



Notice how the front matter differs for this edition: 

 

Most fiction is drawn from real-life experiences. Notice the disclaimer I use to help avert any 

chance that anyone might get upset about my fiction. 

That covers the front matter. For backmatter (fiction and nonfiction) I usually just use a brief bio. 

You can see it at the end of this book.  

The other files in my Stories from the Cantina folder above are the .epub file I downloaded from 

Barnes & Noble when I first published to them, the PDF file I created from the StoneThread 

version of the book, three photo (.jpg) files that we'll discuss in the section on creating a cover 

for your book, and the .mobi file that I downloaded from Smashwords after conversion. I like 

having those files handy in those formats just in case I want to give one away. 
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Submitting to Smashwords 

The Smashwords submission process is relatively straightforward. You have to go to 

http://smashwords.com, set up an account, and read the instructions. I suggest you have your 

PayPal or bank account information ready. You’ll have to tell them how to pay you. They’ll also 

want your bio and the URLs (website addresses) for your website, your LinkedIn and Facebook 

and Twitter and MySpace accounts if you have them.  

When your manuscript is prepped and ready to go, your promo doc is ready, and you have a 

cover for your ebook (we’ll talk about options for ebook covers toward the end of this book), 

sign into your Smashwords account and click the Publish link in the menu at the top of the page. 

http://smashwords.com/


 

It will take you to another page (below). The next six screenshots are of that page, from top to 

bottom. In the first you'll enter the title of your book (be exact) and then a short description. You 

have only 400 characters (not words) for the short description, so be concise. You can probably 

glean the short description from the longer description you wrote for your Promo document. Be 

sure to spell check everything in your Promo doc so you don’t embarrass yourself when you add 

the information to the screen at Smashwords, Amazon, etc. 

 

In the next screenshot, you’ll place the long description (copy and paste from your Promo 

document). Note that the long description is optional. Then check the language in which your 

book is written (defaults to English) and then select whether your book contains adult content. 

Use your own best judgment.   



 

In the next screenshot, you'll set Pricing, Sampling and Categories. Short stories should be set at 

$0.99. I recommend $1.99 to $2.99 for short collections (5 or 6 stories) and novellas, and $3.99 

to $4.99 for longer collections (10 stories) and novels. Nonfiction works and poetry collections 

will be priced differently. Of course, you can charge whatever you want. I usually set the 

Sampling to either 10% or 20%. The Categories section is self-explanatory. 

 



In the next section you'll add keywords (tags) to help search engines find your book. You can see 

some examples from my Stories from the Cantina promo document above. Be sure to include 

your last name as one tag. If your last name is Smith or Jones, you might consider using your 

whole name as a tag.  

After you set the tags, select which ebook formats you want. For this particular book, because 

with all the screenshots it would not translate well into most formats, I selected only .epub and 

PDF. For most of my books, though, I select all except the last two, RTF and Plain Text, which 

are cut off in this screenshot. I don’t like the idea of some reader altering my book. 

 

Now you can move on to uploading your cover image. (Again, we’ll talk about options for ebook 

covers toward the end of this book.) I mimic Smashwords in urging you not to upload your other 

material until you have a good cover.  

 

And in the final screenshot for Smashwords you'll upload your actual book file. Remember to 

upload the Smashwords version. After that, read the Publishing Agreement in 8 below and then 

click Publish.  



 

That was relatively easy, wasn't it? No matter how confusing it seems now, once your document 

is prepped and your cover is finished and you have a Promo file to draw from, it really is a snap. 

But I mentioned earlier that I distribute to Amazon, Barnes & Noble and a few others myself, 

right?  
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ISBN and Distribution 

Note that you do not have to purchase an ISBN. Once your book is published through 

Smashwords, you can assign it a free Smashwords ISBN. Smashwords will even send you an 

email prompting you to do so. I strongly recommend you use their ISBN. It costs nothing, and it 

lists Smashwords as the publisher of record, but if you follow my instructions above, 

Smashwords will actually be publishing "the Smashwords Edition" of <your publisher name> 

book. Of course, Smashwords will also sell you an ISBN for  $9.95 and list you as the publisher 

of record. You'll see these options right after your book is published. When you get to the ISBN 

Manager, take a few minutes to read the instructions. Then scroll down and assign your ISBN. 

The following screenshot is of the menu on the left side of my Smashwords Dashboard. 

Note the ISBN Manager (bottom) and the Distribution Channel Manager (third from 

bottom): 



 

Once the ISBN is set, you should go to the Distribution Channel Manager. Once again, when you 

get to that page, take a few moments to read the instructions, then be sure "opt in" is marked for 

all sales channels for which you want Smashwords to serve as your distributor.  

If you’re going to send your work to Amazon yourself (recommended) and to Barnes & Noble 

yourself (not recommended), opt out for them. This will keep Amazon, for example, from having 

one copy of your book from you and another one from Smashwords.  

Here's a screenshot of the Distribution Channel Manager entry for my short story collection, 

Stories from the Cantina. Note that I opted out of letting Smashwords ship to Amazon and 

Barnes & Noble: 

 

As of this writing, Smashwords hasn't ironed out distribution details with Amazon anyway, 

though they're working on it. Also as of this writing, my sales are so low through B&N that I 

now let Smashwords distribute to them for me. 



After your book is approved for inclusion in the premium catalogue, it takes Smashwords 

another week or so to ship your book to the retailers. According to Smashwords, at B&N and 

Kobo, books usually appear within a few days after shipment. At Sony, books appear about two 

weeks after shipment. Apple manually reviews all books they receive, so it sometimes takes 

books a month to appear there.  

Note that this still beats submitting a manuscript to a publisher, not hearing back for six to eight 

months and then, if the manuscript is accepted, waiting up to another year to see your books 

published. And when they’re published you’re lucky to draw a 12% or 15% royalty.   
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Submitting to Amazon 

Here are some screenshots of the Amazon process. When you first create an account with 

Amazon, be sure to have your banking information at hand so you can tell them how to pay you. 

Create an account at https://kdp.amazon.com/self-publishing/signin.  

Remember to submit your personal version of the Word document (not the Smashwords version) 

to Amazon. Also, the price you set here should be the same price you set at Smashwords. 

These are the actual pages from when I submitted my collection, Stories from the Cantina: 

 

These just follow a sequence. All of the vendors generally require the same information, but in 

different sequence. Attention to detail is important. For example, see number 2 below. 

https://kdp.amazon.com/self-publishing/signin


 

Before they'll let you upload your book file, they'll require you to select Enable Digital Rights 

Management or Do Not. I no longer recommend DRM. Most people are basically honest, and 

those who are not will take what they want anyway. 

 

Again, attention to detail. Be sure to check Worldwide rights in 6 below. Then Amazon will sell 

your book in Germany, the UK, and over a dozen other places. (For the current list, see 

http://stonethreadpublishing.com/faq/ .) The Choose Your Royalty option is important for 

obvious reasons. If your book is price $2.99 or higher, I recommend choosing the 70% royalty. If 

it's priced lower than that, you have to choose the 35% option. That still isn't bad when you 



consider, if your book is traditionally published through even a major New York house, your 

earnings probably will be between 8% and 12%. Ugh. All of a sudden 35% on a dollar doesn't 

seem all that bad. As you can see, because this collection is priced at $2.99, I'm collecting the 

70% royalty. 

 

And here's the bottom of the page. Click the little box beside "By clicking Save and Publish 

below...", then click Save and Publish and you're done. On to Barnes & Noble. 
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Submitting to Barnes & Noble PubIt 

Again, B&N seems to be my worst sales venue for fiction, poetry and nonfiction, so I let 

Smashwords distribute to them for me now. However, you certainly may submit your work 

directly to them if you wish. Again, when you first create an account with them, be sure to have 



your banking information at hand. 

Create an account at http://pubit.barnesandnoble.com/pubit_app/bn?t=pi_reg_home. Here are 

five more screenshots, and all of these are from B&N. Under 2 below, after you've uploaded 

your ebook, you can download the epub file that B&N prepared. I recommend doing so. 

Remember, submit your personal version of the Word document (not the Smashwords version) 

to B&N. The price you set here should be the same price you set at Smashwords and Amazon. 

 

In the next section you upload your cover image.  

 

Attention to detail rears its ugly head again. Be very careful to answer all the little questions.  

http://pubit.barnesandnoble.com/pubit_app/bn?t=pi_reg_home


 

I get a laugh out of this next section. "Don't be shy" they say. Have they ever met a writer? 

 

And again to the end. If you've been fortunate enough to have an editorial review published in a 

newspaper or other review source, you can list it here. Otherwise just check the right blocks and 

click the green Publish button. (This particular screenshot says Save & Post Changes because I 

brought it up after Stories from the Cantina was already published.) 



 

Now that your manuscript is prepped and you have a good idea how to actually submit it to 

Smashwords, Amazon and Barnes & Noble, let's take a look at ebook covers. Remember, you 

want to have the cover done and in your file folder before you go to Smashwords, Amazon, 

Barnes & Noble, etc. 
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Notes on Ebook Covers  

I used to create two different sized covers, one for Smashwords and Amazon that was about 450 

x 675 pixels and one for Barnes & Noble (they required a slightly larger cover) that was 550 x 

825 pixels. The thumbnail covers I used on my old website were 85 x 128. If I wanted to list my 

book on IMFaceplate and some of the other social networking sites (listed later under 

"Marketing") they have their own requirements. It was quite a headache. I created those covers in 

Microsoft Word, saved them in Paint, etc. It was a tedious, demanding process, and all to get 

very low-resolution covers at about 72 dpi (dots per inch).  

When Smashwords, Amazon and others raised the size, resolution and clarity standards for 

ebook covers, I was annoyed at first. But the fact is, that action prompted me to come up with a 

solution. Now my ebook covers (both my personal covers and those I create for others) are 2000 

x 3000 pixels. That’s after I pare them down from their original 6000 x 9000 pixel size. Oh, and 

those are at 300 dpi. As you might imagine, you can pretty much see them—clearly—from Mars.  

Here’s what I recommend: 

1. If you’re looking for a traditional, no-fees, royalty paying epublisher, check out StoneThread 

Publishing at http://stonethreadpublishing.com/subs. If your manuscript has been edited or 

http://www.imfaceplate.com/
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doesn’t need to be edited and if you think it’s a fit for StoneThread, submit it to me. If I select it 

for publication, the formatting and cover design are on my dime and you earn the lion’s share of 

the royalties, as you should, at 70%. Consider, most “traditional” print publishers offer only a 

50% or smaller royalty on ebooks, their ebooks generally are lower quality because they’re 

behind the learning curve, and their distribution network is no larger than ours. 

2. If you’re dead set on publishing your work yourself and you want a high-quality ebook cover 

for a reasonable price without doing it yourself, email me at h_stanbrough@yahoo.com and tell 

me about your book. Mention that you have this book and I’ll give you  $10 off the cost of a 

cover. You can see some of the ebook covers I’ve created at  http://stonethreadpublishing.com 

and at http://www.HarveyStanbrough.com/covers. 

3. Go to your favorite search engine (Google, Yahoo, etc.) and key in “Ebook Covers.” Then 

browse. 

Okay, so if you want to create your own cover and you know how to use Adobe Photoshop or 

a similar program, you should have no problem. Smashwords prefers the cover to be at least 

1600 x 2400 pixels. I suggest you go with that size or larger (to stay ahead of the curve).  

If you don’t own such a program, you can download a free Adobe-like program called GIMP 

(GNU Image Manipulation Program) at http://www.gimp.org. Some folks have had great success 

with it and there are various GIMP tutorials online. I was not one of those folks. After nearly 

drowning in Photoshop Elements 9 and seeing that GIMP was similar, I opted to look around. 

I’ve never regretted that decision. If you don’t mind spending about $100, I strongly recommend 

a Brit company called Serif at http://www.serif.com. I bought their PagePlus X6 program. It’s 

basically a desktop publishing program, but it has all the tools I need to create excellent covers. 

It’s extremely intuitive and has a very short, shallow learning curve. I also recommend their 

PhotoPlus X5, and they have several other excellent products. 

If you choose to create your own covers, here are a few standard tips: 

1. For my own covers and my StoneThread Publishing covers, I go with a 1:1.5 ratio, meaning 

my ebook covers are 1.5 times taller than they are wide (hence, 2000 x 3000 pixels). Don’t go 

with a lesser ratio than 1:1.5. 

2. Unless your cover is very dark, add a 6 to 10 point border (line) around it to make it pop off 

the page. 

3. With print book covers, any text has to be at least one inch from the fold and the trim-size 
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edge of the cover. With ebooks there is no such restriction. Certainly you want a bit of a border 

around the title and author name, but make those as large as you can without making the cover 

look gaudy. Remember, the first time the reader sees the cover it will be in thumbnail size, 

usually 200 x 300 pixels or smaller. 

4. Be sure the cover looks good in black and white or greyscale as well as in full color. Many 

ereader devices are black and white. 

If you have questions regarding cover design or epublishing, don’t hesitate to send me an email. I 

usually respond fairly quickly, and if I know the answer to your question it might save you a lot 

of trial and error. 

Return to Top 

Marketing 

Once your book is published the real work begins: marketing. Especially if you go the 

epublishing route, but even if you’re a traditionally published or self-published print author, 

you’ll need an Internet presence. 

A lot of people talk about how important it is for an author to have a website, but it isn't all that 

important. It might take you a year or more to build your website traffic to levels that will make 

even the slightest difference. If you spend most of your marketing time hyping your books on 

your own website, but only a few hundred people even know your website exists, your sales will 

be dismal at best. If you decide to have a web presence, use it to direct prospective customers to 

Smashwords, Amazon, etc.  

I also recommend you key “Book Marketing” and even “Ebook Marketing” into your search 

engines and see what pops up. You can sign up for a free newsletter at Author Marketing Experts 

and I’ve heard nothing but good things about Book Marketing Buzz. Mark Coker of Smashwords 

also puts out a Smashwords Book Marketing Guide. I haven’t read it yet, but if it’s anything like 

his style guide, it’s chock full of great information, although you might have to work a bit to 

glean the seed from the chaff. 

If you key "Social Networking Sites" into your search engine, you will find there are dozens of 

them. I've tried many of them, and the ones I find most useful are Twitter (http://twitter.com), 

Facebook (http://www.facebook.com) and LinkedIn (http://LinkedIn.com). Nothing Binding 

(http://www.nothingbinding.com) is interesting and might become a better tool, and Scribd 

(http://www.scribd.com) isn't bad either. I also looked into one called IMFaceplate 
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(http://www.imfaceplate.com) but don't see it as being all that useful. However, you might like it. 

If you want to link up with me on any of those venues, follow these links. Please copy and paste 

the links into your browser if necessary: 

Twitter: http://twitter.com/#!/hstanbrough 

Facebook: https://www.facebook.com/AuthorStanbrough 

Linked In: http://www.linkedin.com/in/harveystanbrough 

Of course, you can also find me here: 

My Website: http://HarveyStanbrough.com 

StoneThread Publishing: http://StoneThreadPublishing.com 

Smashwords: http://www.smashwords.com/profile/view/HStanbrough 

 

Ends 
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